Understanding
Excel Add-Ins
Add-ins are used to add
functionality to Excel.
Some are supplied with the
product, and there are many
others available for purchase
or for free download.
By Mike Lewis

M

icrosoft Excel is an extremely sophisticated program but it can’t meet the
needs of all its users all the time. Some users will find certain tasks difficult
to accomplish, and others will want to achieve things which the product
is simply not capable of doing. There will probably also be times when you wished
you had a way of extending the program’s functionality to meet some special need.
In all these cases, the solution might lie in an add-in. Excel add-ins are small
programs, written either by Microsoft or third parties, which extend and enhance
Excel in various ways. They work inside Excel and, if designed properly, will be
more or less transparent to the user - they will look and feel just like part of the main
program.
Add-ins can be written in languages such as C and compiled to a DLL, or they can
be Excel macros, written in VBA or the older macro language, and saved in a special
add-in format. Either way, the source code is hidden from the user and so cannot be
tampered with.
Around a dozen add-ins are supplied with Excel, and several others are available
for download from Microsoft’s Web site. There is also a thriving market for thirdparty add-ins. Some of these are sold as commercial products; others are shareware
or freeware. If there is a particular feature which you feel Excel lacks, a Web search
for a suitable add-in might well provide the solution.
So what exactly do these add-ins do? Some are Excel functions - the type you use
when writing formulae. These typically perform specialised calculations such as
statistical, financial or engineering functions. Others are wizards which generate
formulae or macros. And some are more like mini applications in their own right.
There are add-ins which create business plans, perform risk assessments, appraise
investments, generate reports, provide links with proprietary data sources, and
reach out to the Internet to retrieve share prices and company data. Surprisingly,
even the auto-save function in Excel 2000 is implemented as an add-in.

Installing And Activating
The add-ins that are supplied with Excel are not installed by default. In Excel 2000
and XP the supplied add-ins are all flagged for install on first use. Users who attempt
to use an add-in for the first time might be discouraged by the need to hunt for the
installation CD or connect to the appropriate server, and many might decide not to
bother. In the case of Excel 97, a few of the add-ins are installed with the typical setup
but most of them must be installed manually with a custom setup.
Given that there is virtually no performance penalty in installing an add-in - other
than the very small amount of disk space that it occupies - it would make sense to
change your installation parameters so that all the add-ins that your users are likely
to need are always installed on their hard disks.
After you have installed an add-in, it is not immediately available to the user. Before
it can be used, you need to activate it. You do that by selecting the appropriate item
in the Add-Ins dialog (see Figure 1), which you reach from the Tools menu. Once
you have done that, the add-in will be loaded each time you launch Excel. This will
add to the time it takes Excel to load, and will also reduce the amount of memory
available to the program.
For add-ins which you don’t use every day, it is more efficient to activate them only
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when they are needed and to deactive them before quitting Excel. Deactivating an
add-in does not release its memory in the current session, but it does prevent it from
being loaded the next time you launch Excel. If you want to check which add-ins
have been installed, look for files with extensions DLL, XLA or XLL in either the
Library or Profiles folders within the main Office directory. If an add-in has been
installed but is not visible in the Add-Ins dialog, click on the Browse button in that
dialog, navigate to the above folders, and select the appropriate file.

Troubleshooting
If you do load add-ins automatically when you launch Excel (that is, if you leave the
appropriate items selected in the Add-Ins dialog), you could find that a buggy add-in
will prevent Excel from loading. And if you can’t launch the program you will have
no way of getting to the Add-In dialog to deactivate the add-in. The solution is to
launch Excel with /automation as a command-line parameter. This prevents the
add-ins from loading. You can then try to activate each add-in in turn until you have
identified the culprit.

Available Add-Ins
For the rest of this article, we will look at some of the add-ins which you might come
across, starting with those which are supplied with the Excel (and Office) package.
Unless otherwise stated, all these add-ins come with all recent versions of Excel (97
to 2002). You can find more information about them in the Excel help file.

Access Links
When you activate this add-in, it adds three commands to the Data menu. “MS
Access Form” uses the Access form wizard to create a form. You can then use the
form to enter data into an Excel list. “MS Access Report” uses the Access report
wizard to create a report based on the data in an Excel list. “Convert to MS Access”
launches a wizard which converts an Excel list to an Access table.
After creating a form or report, the relevant wizard will place a button in the
worksheet. You can use this to recall the form or report. For the third command, the
wizard adds a message to the worksheet to remind you that a copy of the data now
resides in an Access database.
Of the three commands, the reporting option is probably the most useful. If you
want to enter data via a form, Excel’s built-in Forms tool (on the Data menu) will be
faster, although the Access version gives you more control over the layout. For
converting data, Access’s import feature works just as well.
The Access Links add-in requires Access to be installed. The add-in is supplied with
Excel 97 and 2000, but Excel 2002 users must download it from Microsoft’s Web site
at http://office.microsoft.com.

Analysis ToolPak
This add-in provides 15 specialist engineering and statistical functions such as
correlation analysis, exponential smoothing, Fourier analysis, and rank and percentile analysis. You access the functions by selecting Data Analysis from the Tools
menu. In each case, the add-in prompts you for the input parameters (see Figure 2)
then writes the results to a specified range in the worksheet.

AutoSave
In Excel 97 and 2000, you need to activate this add-in if you want to tell Excel to
automatically save your workbook every so-many minutes. You do this by selecting
AutoSave from the Tools menu. In Excel 2002 this function has been replaced by the
Auto Recovery feature.

Conditional Sum Wizard

Figure 1 - Use this dialog to
activate your add-ins.
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Suppose your worksheet contains two columns: a column of figures, such as
turnover or salaries; and a column containing the categories (departments, regions,
or something similar) to which the figures apply. You want to create a summary
showing, say, turnover per department. This add-in will do just that. It launches a
wizard (see Figure 3) which prompts you for the required information. It then
generates a formula (essentially a nested IF() function) which in turn performs the
necessary calculations. You launch the wizard from the Tools menu.
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Euro Currency Tools
Activate this add-in if you want to use Excel’s EUROCONVERT() function. This
function converts between member currencies and euros using a built-in table of
fixed exchange rates, in accordance with the EU triangulation rules. You pass three
parameters: the amount to be converted, and the ISO currency codes of the source
and target currencies. The function saves you having to manually enter exchange
rates, which is time-consuming and error-prone.
In addition, the add-in places a euro button on the formatting toolbar. This button
formats values in the euro style, that is, rounded to two decimal places, with a euro
symbol, and with decimal and thousands separators as specified in the regional
settings (euro font support is required to display the euro symbol). The add-in was
not supplied with Excel 97, but users of that version can download a separate euro
button add-in from Microsoft’s Web site.

Lookup Wizard
This is a handy tool for worksheets which contain lookup tables. If you have a table
of, say, product codes and corresponding product descriptions, the wizard will
generate a formula which returns the description for a specific code. You could, of
course, write the formula yourself, using the INDEX() and MATCH() functions, but
the wizard greatly simplifies the process. You access the wizard from the Tools
menu.

Report Manager
This add-in is useful if you want to print multiple worksheets in one batch. It lets
you create a report which consists of a series of worksheets in a specified sequence.
You can’t choose a print range within a sheet, but the report respects any page breaks
and headers and footers already present. The add-in also supports views and
scenarios. The report can only be printed to paper - there is no preview feature.
You access the Report Manager from the View menu. The report parameters are
saved with the workbook, and can be recalled and edited at any time. You will
probably find the reporting features of the Access Links add-in (described above)
more flexible, but the Report Manager is faster and more convenient. The add-in is
supplied with Excel 97 and 2000, but if you use Excel 2002 you must download it
from Microsoft’s Web site.

Solver

“Lookup Wizard is
a handy tool for
worksheets which
contain lookup tables.
If you have a table of,
say, product codes and
corresponding product
descriptions, the wizard
will generate a formula
which returns the
description for a
specific code.”

This add-in greatly simplifies the task of setting up goal-seeking models. You use it
to find the optimum value of a cell, based on varying values in dependent cells. For
example, in a manufacturing company, an increase in production will add to the
costs of labour, raw materials and storage, which will in turn reduce the net profit.
But it will also decrease the number of stock-outs, which in turn means higher sales

Figure 2 - One of the specialist tools in the Analysis Toolpak.
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and therefore an increased net profit. You need to find the monthly production levels
which will lead to the optimum (that is, maximum) profit figure.
To achieve this, you start by creating a spreadsheet which shows all the monthly
figures (for production level, labour costs, sales etc) and the resulting profit figure.
You enter your best guesses for the production levels. You then launch the solver,
which will proceed to adjust the values in the production level cells, checking the
resulting profit figure each time. The values of the production level which lead to
the highest net profit are the ones that will be retained.
The whole thing is done in a simple dialog (see Figure 4), which you access from the
Tools menu. As well as specifying the target and the varying cells (net profit and
production levels respectively, in this example), you can impose one or more
constraints (for example, you might stipulate the maximum production level which
the factory can support). You can also specify the maximum time that the solver
should spend on the problem, a convergence figure (the solver will stop when the
relative changes in the target figure in the last five iterations are less than this figure),
and several other parameters.

Template Wizard With Data Tracking
The Template Wizard with Data Tracking allows you to set up a simple Excel-based
front end to a central database. Using a data entry form within a worksheet, users
can add new records to the database and update existing records. The database can
be an external Access or .DBF file, or it can be a list within another Excel workbook.
You start by setting up a data entry form. This consists of a simple range within the
worksheet, with a cell for each of the fields within the record and another for each
of the field labels. You then launch the wizard from the Data menu. The wizard
prompts you to identify the input cells and their labels, the name and location of the
database, and a few other items. On completion, the wizard will generate a template,
which you then distribute to the users.
When a user creates a new workbook based on the template, they will see the data
entry form which you have set up. The user can now fill in the form and save the
workbook, at which point a new record is inserted into the database. If the user edits
the same cells, Excel will ask them whether they want to insert another record or
update the existing one.
The add-in offers a very easy way of linking worksheets to a database but it is not
intended to provide a full set of data-handling tools. It has no way of searching,
filtering or sorting the data, nor can you use it to delete a record. Nevertheless, it
does serve as a good starting point. You can extend the template with your own
macros to provide any additional functionality that you need, although you might
find it easier to use the tools provided by the database instead. The add-in is supplied
with Excel 97 and 2000, but Excel 2002 users must download it from Microsoft’s Web
site.

Redundant Add-Ins
There are few Microsoft add-ins which you might come across which are provided
only for backward compatibility purposes. In most cases you can probably ignore
these. The Query add-in lets you convert external data ranges in Excel 97 and later
to Excel 95/5.0 format, and also allows VBA macros that use MS Query to work with
older versions of Excel. The Internet Assistant VBA add-in has been superseded by
the Web folders feature. The Template Utilities add-in contains utilities used internally by certain third-party templates supplied with Office 97. And the Update
Add-in Links add-in provides support for those rare old-style macros that cannot
be automatically converted to VBA. All these add-ins are available with Excel 2000
but have been dropped in Excel 2002.

More Microsoft Add-Ins

Figure 3 - The Conditional
Sum Wizard.
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The add-ins described above are all supplied with the Excel (or Office) package.
However, there are other add-ins available for download from the Office Web site
(http://office.microsoft.com). It’s worth keeping an eye on this site, as new add-ins
(for all Office applications, not just Excel) are being added all the time. Here are some
of the more interesting downloadable ones.
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MSN Money Central Stock Quotes
If you use Excel to analyse market prices of shares or other securities, this add-in
will automatically update the prices in your worksheet. It does this by obtaining
real-time quotes from major markets around the world via the MSN Money Central
Web site. When you activate the add-in, it installs a new toolbar. Click the “Insert
stock quotes” button to enter a list of the securities you are interested in. To retrieve
the latest prices, click the “Insert quotes” button. For this to work, you must already
have launched your browser and be connected to the Internet.

Expanded Help File
The Excel 2002 help file supports a type of expandable link which is incompatible
with most screen reading programs. This add-in provides an alternative help file in
which the links are pre-expanded. The file has exactly the same content as the normal
help file, and, apart from the expanded links, works in just the same way. The only
snag is that the add-in will overwrite the existing help file, so if you need to revert
to the old file, you will have to remove the new one manually, then run the Office
Setup program again.

Microsoft Visual Keyboard
Strictly speaking, this is not an add-in, nor is it specific to Excel, but it is worth
mentioning because it provides a useful solution to an irritating problem. If you ever
need to type in more than one language on the same computer, you will know that
you can easily install multiple keyboard layouts and switch between them via a
button in the system tray. The problem is that, when you select a language other
than the one corresponding to your physical keyboard, the characters that you type
will no longer match the ones printed on the key caps.
The Microsoft Visual Keyboard solves the problem by displaying an image of a
keyboard on the screen. You can either use the image as a guide to help you locate
the keys on the physical keyboard, or you can click directly on the keys on the screen.
When you use the system tray button to switch to a different language, the image
on the screen will change accordingly. Clearly, this tool won’t be suitable for
high-volume multi-lingual data entry, but it should appeal to users who just need
to enter some occasional text in another language.

Third-Party Add-Ins
We’ll finish by looking at a few of the many Excel add-ins available from third-party
vendors. This is just a taste of what’s available. Run a Web search for Excel add-ins
or check your favourite shareware sites to find more.

EuroZap
Despite its slightly off-putting name, this add-in will appeal to users who need to
convert entire worksheets from a member currency to euros or vice versa. The best
way to use it is to let it create a so-called mirror sheet. This is an exact copy of an
existing sheet, but with all the currency amounts converted to the target currency.
The new sheet can include an optional update link to the old one. You can also choose
to generate a table of differences between the old and new.

“Despite its slightly
off-putting name,
EuroZap add-in will
appeal to users who
need to convert entire
worksheets from a
member currency to
euros or vice versa.”

Update 161:April 2002
Page 9

Alternatively, you can use the add-in to generate mirror ranges within a sheet - again,
with an optional update link between the old and new ranges - or to leave the
currency cells in place but to display the converted amounts in a comment. The
add-in supports a number of formatting and filtering options, and is controlled
through a simple toolbar. It is available from InttraSoft (http://www.inttrasoft.com).

Financial Genome
This is a sophisticated tool which will generate a variety of financial models,
including cash-flow statements, final accounts, cost-of-capital analyses, profit analyses and several others. Its aim is to hide the detailed structure of the model from the
users by letting them work with familiar financial terms which they pick from a
dictionary. When you activate it, it adds an Analysis menu and toolbar; these are
used to control all aspects of the program.
The add-in generates all the formulae which make up the model, and updates them
as you refine your requirements. It automatically inserts dependent calculations,
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Figure 4 - This dialog prompts for parameters for the Solver.
relates duplicated terms and totals, substitutes user-specified names, and maps
financial statements to a simple database format. This is a particularly attractive tool
for users who are at home in the world of financial analysis and management
accounts but who are less familiar with the finer points of Excel. It is published by
Modernsoft (http://www.modernsoft.com).

Spheresoft Modeller
This add-in lets you do two things: enter a single value and multiple formulae in the
same cell; and enter formulae which are part of a circular reference. Why would you
want to do that? To create a model in which the user can enter all the known values
and which then calculates all the unknown values. To take a simple example, cell
A1 might contain a formula which converts the value in cell A2 from British pounds
to euros, and cell A2 might contain a formula which does the reverse. The user can
enter a value in either cell and immediately see the converted value in the other cell.
According to Spheresoft, this is “a more intuitive interface paradigm, as it allows
users to work forwards and backwards in a problem”.
An important point about this technique is that the formulae are completely hidden
from the end-user, and are not overwritten when values are entered in the same
cells. Conditional formatting is used to help distinguish calculated values from those
which the user has entered. The program also lets the spreadsheet author specify
default values.
Spheresoft Modeller also supports back-solving. This is similar to the Microsoft
Solver add-in described above. It is useful in cases where you can write a formula
which converts A to B, but there is no corresponding formula to convert B to A. In
these cases, the back-solver will iteratively test different values for A until it finds
one which satisfies B. For further information about the add-in, see
http://www.spheresoft.com.

Summing up

“There are add-ins
available which can
extend and enhance
Excel in all kinds of
interesting ways.”

There are add-ins available which can extend and enhance Excel in all kinds of
interesting ways. Some of them provide shortcuts to things which, with a little effort,
users could do for themselves. Others let you do things which would otherwise be
difficult or impossible. If Excel support is an important part of your work, spend
some time getting to know these add-ins. They can play a valuable role in helping
your users get the most from their spreadsheets.
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New Reviews from Tech Support Alert
Anti-Trojan Software Reviews
A detailed review of six of the best anti trojan software programs. Two products
were impressive with a clear gap between these and other contenders in their
ability to detect and remove dangerous modern trojans.
Inkjet Printer Cartridge Suppliers
Everyone gets inundated by hundreds of ads for inkjet printer cartridges, all
claiming to be the cheapest or best. But which vendor do you believe? Our
editors decided to put them to the test by anonymously buying printer cartridges
and testing them in our office inkjet printers. Many suppliers disappointed but we
came up with several web sites that offer good quality cheap inkjet cartridges
with impressive customer service.
Windows Backup Software
In this review we looked at 18 different backup software products for home or
SOHO use. In the end we could only recommend six though only two were good
enough to get our “Editor’s Choice” award
The 46 Best Freeware Programs
There are many free utilities that perform as well or better than expensive
commercial products. Our Editor Ian Richards picks out his selection of the very
best freeware programs and he comes up with some real gems.
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